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�
Modern Campaigns Scenario Editor


Introduction


�xe "Introduction"�


The Scenario Editor can be used to create new scenarios and to modify existing scenarios for Modern Campaigns. The Editor has full support for all unit placement and modification (such as strength and fatigue modification) and full support for other scenario features (such as objective placement).





This manual last updated: May 29, 2002





Using the Editor


�xe "Using the Editor"�


When the Editor is run, it will normally prompt you for the filename of a scenario to edit.  After you select a scenario and click OK, the Editor will display the full-size map associated with the scenario (see the Initial View submenu in the Settings Menu for how to control which map resolution is initially displayed).  In addition, in the lower right-hand corner of the screen, the Editor will display the Unit Dialog which displays the units which are available to either be placed on the map or placed as reinforcements (see Display Unit Dialog in the Command Menu to redisplay the Unit Dialog if it becomes closed).  If the Prompt for Scenario option in the Settings Menu is not set, then the initial dialog listing the scenarios will not be shown and you will need to select the File New or Open menu item to create or read an existing scenario.  Note: you do not want to modify the original scenarios distributed with Modern Campaigns.  You should make a copy of the scenario file if you want to modify an original scenario.





At any given time, the Editor is either in Move Mode or Place Mode.  By default, the Editor is in Place Mode.  When in Place Mode, clicking on the map with the right mouse button causes the currently selected unit in the Unit Dialog to be placed on the map.  When in Move Mode, right clicking on the map causes the currently selected units to be moved to the selected hex.  When in Place Mode, the cursor is displayed as a cross �.  When in Move Mode, the cursor is displayed as a circle �.  The mode of the Editor can be toggled by clicking on the Mode Button in the Toolbar.  Alternatively, the current mode of the Editor can be toggled by holding down the Control (Ctrl) key.


Placing and Moving Units


�xe "Placing and Moving Units"�


The Unit Dialog displays all of the units in the Order-of-Battle that have not been placed on the map or placed as a reinforcement.  To place a unit on the map, first find the unit in the Unit Dialog and select it.  Then, ensuring that the Editor is in Place Mode, click on the hex to place the unit with the right mouse button.  After placement, the unit will be selected and can be modified relative to such factors as facing and strength by using the Command Menu or buttons on the Toolbar.  To move units from one hex to another on the map, select the selects and, ensuring that the Editor is in Move Mode, click on the hex to move the units to with the right mouse button.  Use Remove From Map in the Command Menu to remove unnecessary units from the map.





It is possible to combine several units from the same organization in one hex into a single Combined Unit.  The units to be combined must all have the same Component and Quality.  See the Command Menu and Toolbar for more on this feature.





Note: the facing of units only affects the appearance of the units in the 3D graphics mode and otherwise has no effect on play.


Adding and Deleting Reinforcements


�xe "Adding and Deleting Reinforcements"�


Adding reinforcements to the current scenario is a two step process.  First, identify the units to be added as reinforcements in the Unit Dialog and place them on the map at the location of the entry hex.  You should ensure that the units have a facing that is appropriate for their entry onto the map and that they are in the appropriate formation such as Travel Mode.  Second, after selecting all of the reinforcements that are to arrive as one group, select Add Reinforcement from the Units Menu.  This will display the Reinforce Dialog so that additional information such as the arrival time can be entered.  Having done this, the units will be removed from the map and a reinforcement entry will be generated for the current scenario.





Reinforcements which have been previously defined can be reviewed, modified, and deleted using the Scheduled Dialog.





The Menus


 File Menu





The File Menu�xe "File Menu"� is used to read and write scenarios from and to disk and to perform other basic file operations.





�Select New to clear any scenario currently in the Editor and to begin a new scenario from scratch.�Select Open to open an existing scenario.  You will be prompted for the filename of the scenario.  Note: you should not make changes to original scenarios distributed with the game software.  If you want to make such a change, you should copy the scenario file to a new filename before editing it.�Select Save to save the current scenario to a file.  If the scenario was previously read from a file, it will by default be written back to the same file.  If the scenario was started from scratch, you will be prompted for the name of the file.�Select Save As to save the current scenario to a different file than the one it was previously read from.  You will be prompted for the new filename.





Each unit in the game is assigned a unit picture that is shown in the Hex Info Area.  The bmp filename of the unit picture is constructed using the name of the nation and the component name of the unit.  Select Missing Unit Pictures to view a list of the units in the current scenario that are missing a unit picture.�You can view the filenames of the Map, Order-of-Battle, and Parameter Data files associated with the current scenario by selecting Filenames.





Select Exit to exit the Editor.


Scenario Menu


�xe "Scenario Menu"�


The Scenario Menu is used to modify basic information about the current scenario such as scenario length and description.





�Selecting Header displays the Header Dialog which can be used to edit basic scenario values.�Selecting Description displays the Description Dialog so that the scenario description can be entered and modified.�Select Air Support to display the Air Support Dialog which allows air units to be added to the current scenario.


Command Menu


�xe "Scenario Menu"�


The Command Menu is used to modify information about units that have been placed on the map.  Most operations in the Command Menu are applied to the currently selected units in the Hot Spot.





�Select To Top of Stack to move the currently selected units to the top of the stack.�Select To Bottom of Stack to move the currently selected units to the bottom of the stack.�Select Turn Clockwise to turn the currently selected units one hexside in a clockwise direction.�Select Turn Counterclockwise to turn the currently selected units one hexside in a counter-clockwise direction.�Select Change Travel Mode to toggle the state of the currently selected units between Travel Mode and non-Travel Mode.�Select Change Rail Mode to toggle the state of the currently selected units between Rail Mode and non-Rail Mode.�Select Increase Strength to increase the strength of the currently selected units by 1 man, gun, or vehicle.  Holding down the Alt key while selecting this increases the strength by 10 men, guns, or vehicles.�Select Decrease Strength to decrease the strength of the currently selected units by 1man, gun, or vehicle.  Holding down the Alt key while selecting this decreases the strength by 10 men, guns, or vehicles.�Select Increase Fatigue to increase the fatigue of the currently selected units by one.  Holding down the Alt key while selecting this increases the fatigue by 10.  This should be used to represent fatigue accumulated from combat previous to the current scenario.�Select Decrease Fatigue to decrease the fatigue of the currently selected units by one.  Holding down the Alt key while selecting this decreases the fatigue by 10.�Select Toggle Disrupted to toggle the Disrupted state of the currently selected units on and off.�Select Toggle Low Ammo to toggle the Low On Ammo state of the currently selected units on and off.�Select Toggle Low Fuel to toggle the Low On Fuel state of the currently selected units on and off.�Select Toggle Stockpiled to toggle the Stockpiled state of the currently selected units on and off.�Select Toggle Fixed to toggle the Fixed status of the currently selected units on and off.�Select Toggle Facing to toggle the Facing state of the currently selected units on and off.�Select Toggle On Foot to toggle the On Foot state of the currently selected motorized or mechanized infantry.�Select Combine/Breakdown to combine the selected units into a single Combined Unit or to breakdown a Combined Unit into a subunit. Note: holding down the Alt key when selecting this option will cause all possible units in the current hex to be Combined regardless of which units you have selected.�Select Deploy/Recall Deception to convert any deployed Deception Units in the current hex to normal units, or to deploy the selected Deception Units in the current hex.





Select Remove From Map to remove the currently selected units from the map.  Units that are removed from the map will automatically reappear in the Unit Dialog for use elsewhere in the scenario (see Confirm Unit Removals in the Settings Menu).





Select Display Unit Dialog to redisplay the Unit Dialog if it has been closed for whatever reason.


Engineer Menu


�xe "Engineer Menu"�


The Engineer Menu is used to modify Engineer units that have been placed on the map.





� Select Toggle Bridge to establish or remove engineer bridges.  The selected units must be Bridge Engineer units.  If establishing an engineer bridge, then you will be prompted for the direction in which to establish the bridge.�Select Toggle Has Boats to toggle the Has Boats state of the currently selected engineer units.�


Hexes Menu


�xe "Hexes Menu"�


The Hexes Menu is used to modify values associated with map hexes such as fortifications and objectives.





�Select Add/Remove Objective to display the Set Objective Dialog so that Objectives can be added or removed from the current Hot Spot hex.�Select Add/Remove Supply Source to display the Supply Source Dialog so that Supply Sources can be added or removed from the current Hot Spot hex.�Select Add/Remove SAM Site to display the SAM Site Dialog so that SAM Sites can be added or removed from the current Hot Spot hex.�Select Add/Clear Improved to place the editor in Improved Position mode.  In this mode, left clicking will place Improved Positions in the selected hex.  Right clicking in the same hex will remove them.�Select Add/Clear Trenches to place the editor in Trench mode.  In this mode, left clicking will place Trenches in the selected hex.  Right clicking in the same hex will remove them.�Select Add/Clear Mines to place the editor in a mine placement mode.  In this mode, left clicking will place mines in the selected hex.  Mines are first placed as Obstacles, then in single strength, then double strength, and finally triple strength for each left click.  Right clicking in the same hex will lower the strength of the mines in that hex and will finally remove them.�Select Add/Clear Chemicals to place the editor in chemical placement mode.  In this mode, left clicking will place chemical markers in the selected hex.  Right clicking in the same hex will remove the chemical marker.�Select Add/Clear Bunkers to place the editor in Bunkers mode.  In this mode, left clicking will place Bunkers in the selected hex.  Right clicking in the same hex will remove them.�Select Add/Clear Pillboxes to place the editor in Pillbox mode.  In this mode, left clicking will place Pillboxes in the selected hex.  Right clicking in the same hex will remove them.�Select Add/Clear Impassible Hexes to place the editor in Impassible Hex mode.  In this mode, left clicking will define the selected hex as Impassible.  Right clicking in the same hex will remove this condition on the hex.�Select Set/Clear Rubble to add or remove Rubble from the current Village, Town, City, or Industrial hex.�Select Set/Clear Vacated to toggle the Vacated status of a hex containing a fortification such as Improved, Trench, Bunker, or Pillbox.�Select Set/Clear Penetrated to toggle the Penetrated status of a hex containing Mines.�Select Set/Clear Rail Damage to toggle the damage to a hex containing a rail line.�Select Establish Bridge/Ditch Damage to display the Bridge Damage Dialog so that damage to bridges or AT-Ditches can be defined in the current hex.�Select Set/Clear Full-Hex Bridge Damage to toggle the damage of full-hex bridges in the current hex.�Select Set/Clear Wired Bridge to toggle the Wired state of the full-hex bridge in the current hex.�Select Establish Anti-Tank Ditches to display the Anti-Tank Ditch Dialog so that Anti-Tank Ditches can be placed or removed from the map.


Select Shift Units on Map to cause the Shift Dialog to be displayed so that the location of units on the map can be shifted.


Units Menu


�xe "Hexes Menu"�


The Units Menu is used to display and modify the reinforcements and Fixed unit releases in the current scenario.





�Select the Scheduled menu item to display the Scheduled Dialog which allows the list of reinforcements for the current scenario to be viewed, modified, and deleted.�To create new reinforcements, first place the units to become reinforcements on the map at their entry hex.  Adjust the facing of the units so it is appropriate for their entry onto the map. Select all of the units to make up a reinforcement group, and then select Add Reinforcement to display the Reinforce Dialog.  This dialog will allow additional information such as the arrival time to be entered.�Select Add Release to display the Add Release Dialog so that Releases of Fixed units can be added to the current scenario.�Select View/Delete Releases to display the Release Dialog so that Releases can be viewed and deleted.�Select Corps Attachments followed by a selection of either side to display the Corps Attachment Dialog so that Corps Attachments defined for the current scenario can be view, added, or deleted.�Select Supply Variations to display the Supply Variation Dialog so that the list of Supply Variations can be viewed, added, or deleted.�Select Withdrawals to display the Withdrawal Dialog so that the list of Withdrawals associated with the current scenario can be viewed, added, or deleted.





A/I Menu


�xe "A/I Menu"�


The A/I Menu allows you to edit A/I Orders associated with the scenario that will be used by the main program in its A/I routines.





�Select Add Active Order to add an Active A/I Order to the current scenario.  Prior to selecting this option, first Highlight the organization to receive the order and click on the destination hex of the order.  Adding an A/I Order to the scenario will cause the the Main Program to use this as the initial order for that organization when the side is played using A/I.  When defining A/I Orders for sub-organizations of organizations with A/I Orders, be sure to define the A/I Order for the sub-organization after the A/I Order for the larger organization.�Select Add Hold Order to add a Hold A/I Order to the current scenario.  A Hold Order differs from an Active Order in that a Hold Order does not have a destination.  Rather a Hold Order instructs the A/I in the main program to avoid moving the forces in the selected organization until such time as the main program changes the A/I Order for this organization.�Select View/Delete Orders to display the A/I Order Dialog so that the list of A/I Orders, both Active and Hold, defined for the current scenario can be viewed and/or deleted.





Select Add Bridge Order to display the A/I Bridge Command Add Dialog so that new Bridge Commands for the A/I can be added to the current scenario.�Select View/Delete Bridge Orders to display the A/I Bridge Command View Dialog so that the complete list of A/I Bridge Commands can be viewed, modified, or deleted.





Select Add Deception Deploy Hex to add the current Hot Spot hex to the list of hexes the A/I will use when deciding where to deploy Deception Units.�Select View/Delete Deploy Hexes to display the AI Deception Deploy Hex Dialog so that the list of hexes defined to be used for A/I Deception Unit deployment can be viewed.





Info Menu


�xe "Info Menu"�The Info Menu is used to display summary information about the current scenario such as the strength of on-map units and the ownership of map objectives.





�Select Strength to display the Strength Dialog.  This will show the total strength of all on-map units in the current scenario.�Select Objectives to display the Objectives Dialog to see a complete list of all of the Objectives associated with the current scenario.�Select Supply Sources to display the Supply Sources Dialog to see a complete list of all of the Supply Sources associated with the current scenario.


View Menu


�xe "View Menu"�The View Menu is used to establish display settings such as the map display resolution and the display of various scenario on-map data such as objectives.





�Select Units Off to hide the units that are currently on the map.  This is used when you need to see map details that are hidden by the units.�Select Unit Bases Off to hide the unit bases that are drawn in 3D graphics mode.�Select Objectives to toggle the display of Objectives on the main map and the Jump Dialog.�Select Supply Sources to toggle the display of Supply Sources on the map.�Select Locations to display the Location Dialog.  This displays a list of all the map locations.�Select Full Screen Map to toggle the display of the Hex Info Area.  When the Hex Info Area is hidden, more of the map is displayed.�Select Map Contours to toggle the display of contours on the map that show elevation changes.  This can be used to see elevation changes more clearly, especially in 3D graphics mode.�Select Show Organization to display the Organization Dialog in order to display organizations on the map.�Select Find Unit to display the Find Unit Dialog.  Using this dialog, you can find any leader or unit that is currently on the map.�Select Jump Dialog to display the Jump Dialog which enables you to quickly go to any location on the map.�Select Divisional Markings to toggle the display of color bars on each counter indicating the Division or other higher level organization the unit is associated with.�Select Special Markers On Top to toggle the display of special markers such as fortifications on top of the unit stack instead of underneath.�Select Area Boundaries to toggle the display of area boundaries on the map as yellow lines.�Select Hex By Coordinate to display the Hex Coordinate Dialog so that you can jump to a specific hex coordinate location on the map.�Select Shade to display the Shade Submenu described below.�Select Highlight to display the Highlight Submenu described below.





Select 2D Normal View (Hot Key 2) to display the map in normal size 2D graphics mode.�Select 2D Zoom-Out View (Hot Key 1) to display the map in reduced size 2D graphics mode.�Select 3D Normal View (Hot Key 4) to display the map in normal size 3D graphics mode.�Select 3D Zoom-Out View (Hot Key 3) to display the map in reduced size 3D graphics mode.


Normally the screen is recentered on the Hot Spot hex when you change zoom modes.  If you hold down the Alt key when you change zoom modes, the screen will retain the current view.





The Shade Submenu allows hexes on the map to be shaded according to certain criteria.  Selecting a mode that has already been selected turns that mode off.


�Select Visible Hexes to shade all hexes that are not visible from the current Hot Spot hex.�Select Command Range to shade all hexes that are beyond the Command Range of the currently selected Headquarters unit.�Select Maximum Range to shade all hexes that are beyond the maximum firing range of the current selected unit.


The Highlight Submenu displays a list of unit types and status values that may be selected to Highlight certain units on the map.  Selecting any of these modes turns off any other highlighting mode that has been set.  Selecting a mode that has already been set turns that mode off.


�Select Fixed Units to Highlight units on the map which are currently Fixed.�Select Low on Ammo or Fuel to Highlight units on the map that currently have reduced ammo or fuel.�Select Disrupted Units to Highlight units on the map that are currently Disrupted.�Select High Fatigue Units to Highlight units on the map that have a Fatigue value of 200 or more.�Select Non-Full Strength Units to Highlight units on the map whose strength value is less then their nominal full-strength value.�Select Headquarters to highlight all Headquarters currently on the map.�Select Engineers to highlight all Engineer, Mine Clearing, and Bridge Building units on the map.�Select Organization to highlight all units of the same organization as the top selected unit in the Hot Spot.  For example, selecting an infantry unit in a Regiment and then choosing this Highlight option will cause all units in the same Regiment to be highlighted.  Selecting a headquarters and then this option will cause all units under the command of the selected headquarters to be highlighted.  Holding the Alt key while making this selection causes the next higher organization to be highlighted.�When a unit capable of Indirect Fire is selected, then select Indirect Fire Spotters to highlight all units on the map that can act as spotters for fire from that unit.�Select Single Use Units to highlight all Single Use units on the map.�Select Road Stacking Limits to highlight all stacks of units on the map that exceed the Road Movement stacking limit.


Settings Menu


�xe "Settings Menu"�The Settings Menu is used to establish certain Editor settings that are preserved when the Editor is exited and restored the next time the Editor is run.  These options are stored in the Windows Registry.





�Selecting the Prompt for Scenario option causes the Editor to display an Open dialog when it first starts up.  This is a quick way of selecting an existing scenario to edit.�Selecting the Beep on Error option causes the Editor to generate a beeping sound whenever you perform an invalid operation.�Selecting the Blink Hot Spot option causes the red outline in the Hot Spot hex to blink.�Selecting the Smooth Scroll option causes the map to scroll smoothly from one part of the map to another whenever the Hot Spot  is relocated.  With this option turned off, the map display will immediately relocate resulting in faster operation.�Selecting the Auto Scroll option puts the map in a mode where moving the mouse cursor to any edge of the screen will automatically scroll the map in that direction.  When this option is turned off, normal Windows scroll bars are displayed when the map is larger than the screen area.�Selecting the Graphical Unit Icons option causes graphical icons to be used in the display of 2D counters.  With this option turned off, schematic icons are used.�Selecting the Hex Outline option causes outlines to be drawn around the hexes in both 2D and 3D graphics mode.�Selecting the Confirm Unit Removals option causes the Editor to prompt before removing units from the map (see Remove From Map in the Units Menu).�Selecting the Complete Toolbar option causes the Editor to display all available buttons in the toolbar regardless of screen resolution.  Under lower screen resolutions, this will cause the toolbar to wrap thereby reducing the amount of space available to display the map.�Selecting the Alternative Highlighting option causes Highlighted units to be displayed with a white outline instead of the normal red outline.�Selecting the Alt Label Style option causes labels on the map to be displayed with an alternative style that improves their appearance but with some reduced legibility.�Selecting the 3D Counters option causes the program to display units on the map using counter graphics rather than unit graphics when the program is in a 3D view mode.�Selecting the Alternative Scrolling option causes the program to use an alternative method for scrolling the map that may be slower, but may correct a video display problem that some users have.�Selecting Initial View displays the Initial View Submenu described below.�Selecting Hex Info Area displays the Hex Info Area Submenu described below.





The Initial View Submenu is used to establish the initial map view that is displayed when the Editor is run.


�Selecting Last View causes the Editor to come up in whatever map display mode it was last in.�Selecting 2D Normal View, 2D Zoom-Out View, 3D Normal View, or 3D Zoom-Out View causes the Editor to come up in that view.





The Hex Info Area Submenu is used to determine the location of the Hex Info Area on the screen.


�Selecting Left, Right, Top, or Bottom causes the Hex Info Area to be displayed in the corresponding location on the screen.


Help Menu


�xe "Help Menu"�


The Help Menu is used to display various help and other information about the Editor including this help file and copyright information.





�Select General Help to display the Table of Contents of this help file.�Select Parameter Data to display the Parameter Data Dialog which shows game values specific to the current scenario.





�Select About to display various information about the Editor such as version and copyright.


The Dialogs


Header Dialog


�xe "Header Dialog"�


The Header Dialog is used to modify basic information about the scenario.





�


The Title field is used to enter the title of the scenario.�The Turns field is used to enter the number of turns in the scenario.  Note: the number of hours in each turn is determined by Parameter Data and by day and night.  Typically each day turn will be 2 hours in length and each night turn will be 4 hours in length.�The Year, Month, Day, and Hour fields are used to enter the starting time of the scenario.  The First Side field is used to enter the starting side in the scenario.  The Visibility values are used to determine the minimum, maximum, and starting visibility in the scenario measured in hexes.  During the game, the actual visibility will vary between the minimum and maximum values according to an internal algorithm.  The Conditions values are used to determine the possible ground conditions during the scenario.  During the game, the ground conditions will vary between the best and worst values according to an internal algorithm.  There are four Victory Levels in each scenario.  They are used to determine victory or defeat for the scenario first side.  The four values are Major Defeat, Minor Defeat, Minor Victory, and Major Victory.  If the total Victory Points in the scenario is less than or equal to the Major Defeat value, then the first side in the scenario suffers a Major Defeat (and correspondingly the other side wins a Major Victory).  If the total Victory Points is greater than the Major Defeat value, but less than or equal to the Minor Defeat value, then the first side suffers a Minor Defeat (and the other side a Minor Victory).  If the total Victory Points is greater than the Minor Defeat value and less than the Minor Victory value, then the scenario has ended in a Draw.  If the total Victory Points is greater than or equal to the Minor Victory value, but less than the Major Victory value, then the first side has won a Minor Victory (and the other side suffered a Minor Defeat).  Finally is the total Victory Points is greater than or equal to the Major Victory value, then the first side has won a Major Victory (and the other side has lost a Major Defeat).�The two Supply Levels are used to determine supply conditions during the game.  These values should range between 0 and 100 with typical values ranging from 60 to 90.





The two Guided Missile Experience fields are used to specify non-zero values that will be used to determine increased vulnerability to Guided Missile fire.  See the Users Manual section on Firing for more information.





The two Chemical Limits are used to specify the maximum number of chemical attacks that each side can make in the current scenario.  Note: if one of these values is negative, then it indicates that the side cannot use Chemical attacks before the other side has done so.





The Artillery Mine Limits are used to determine the maximum number of times that the given side can fire artillery mines in the current scenario.


Description Dialog


�xe "Description Dialog"�


The Description Dialog is used to edit the scenario description associated with each scenario.





�This description is displayed by Scenario Selection Dialog.  The description is used to describe historical background information about the scenario.  The Author field is displayed so that the name of the scenario author can be entered and modified.


Unit Dialog


�xe "Units Dialog"�


The Units Dialog displays the units which have not been either placed on the map or placed in a reinforcement in the current scenario.


�Under Available Organizations is an organization tree showing all of the units not yet placed on the map or placed as reinforcements.  This organization tree uses the standard Windows Tree Control and may be navigated in a standard manner (see your Windows documentation for information on this interface).





�To place a unit on the map, it must first be found and selected.  The picture to the right shows how the Unit Dialog appears when an individual unit has been selected, in this case the 1/1 Infantry Battalion of the 1st Infantry Brigade.  Most often, you will select individual companies, battalions, or headquarters for placement on the map.  Higher level organizations such as Divisions and Corps must be placed one unit at a time.  Once you have selected the unit to place and ensuring that the Editor is in Place Mode (see Placing and Moving Units), click on the placement hex using the right mouse button.  This will place the unit on the map, remove the unit from the organization tree, and automatically select the next unit in the tree.  If the currently selected unit is an aircraft unit, then right clicking on the map will place the unit in the list of available air units as shown by the Air Support Dialog.





If you inadvertently or otherwise close the Unit Dialog, it can be reopened by selecting Display Unit Dialog from the Command Menu.


Set Objective Dialog


�xe "Set Objective Dialog"�


The Set Objective Dialog is used to place or remove Objectives in the current Hot Spot hex.





�To establish the current Hot Spot hex as an objective hex, select a nation as the Objective owner and assign a value to the Objective.  To delete an Objective, assign it the nation None or give it a value of 0.





Certain objectives are referred to as Exit Objectives.  An Exit Objective is assigned a nation and given a value of -1 in the Editor.  An Exit Objective should only be placed on the boundary of the map.  Exit Objectives award points to the side assigned to them when units are removed from the map while occupying the Objective hex.  For example, if an Objective is given a nation and the value -1, then it becomes an Exit Objective for that side and that side in the scenario will be awarded points for removing units from the map while occupying this hex.  Note that Exit Objectives never change ownership.


Reinforce Dialog


�xe "Reinforce Dialog"�


The Reinforce Dialog is used to define certain data associated with a reinforcement in the current scenario.





�The Year, Month, Day, and Hour selections are used to establish the arrival date for the reinforcement.  The Probability value is the probability, in percent from 1 to 100, that the reinforcement will arrive at the exact arrival date.  If the probability is 100, then the reinforcement is guaranteed to arrive at the exact arrival date.  Otherwise, the probability is used to determine if the reinforcement will arrive at the arrival date, and if not, that it will arrive at each subsequent turn until it is determined to have arrived.  The Location is the hex coordinates of the arrival hex.  The Scatter value is used for Paratroop reinforcements to determine the possible distance the reinforcements may arrive from the Location hex.  The Protection value is an artificial value introduced into the game to protect the reinforcement from enemy units that are crowding the arrival hex.  If the Protection value is non-zero, then at the moment the reinforcement arrives, any enemy units within the number of hexes in the Protection value from the arrival hex are automatically Broken and any enemy units located in the arrival hex are eliminated.  Typically Protection values are used to protect reinforcements arriving on normal roads, while this value is set to 0 for reinforcements arriving in amphibious or airborne landings.





The flags Paratroop, Glider, Amphibious, and Helicopter are used to flag the reinforcement according to its type.  This affects the manner in which the reinforcement arrives.





The Add to field displays whether the reinforcements will be added to the default list of reinforcements for the current scenario, or if they will be added to a currently selected Reinforcement Strategy.


Scheduled Dialog





The Scheduled Dialog can be used to view, modify, and delete the reinforcements defined for the current scenario.





�


The Scheduled Dialog�xe "Scheduled Dialog"� displays a list of reinforcements scheduled to arrive in the current scenario.  Each reinforcement in general consists of several units.  Clicking on a reinforcement scrolls the map to the arrival hex.  Clicking on Delete will delete the selected reinforcement and return the units in the reinforcement to the arrival hex.  Clicking on Modify will display the Reinforce Dialog allowing the selected reinforcement to be modified.





�Double clicking on a reinforcement entry displays a list of the individual units in that reinforcement.


Release Dialog


�xe "Release Dialog"�


The Release Dialog is used to view and delete existing Releases in the current scenario.





�The Release Dialog displays a list of the Fixed unit releases in the current scenario.  Each release shows a time, date, probability that the release will occur on that time and date, and the organization the release applies to.  When the probability is followed by the letter T, it indicates that the release can also be triggered whenever a unit in the specified organization becomes spotted. When an asterisk (*) precedes the release, it indicates that the release did not occur on the time and date specified.  Selecting a Release entry will cause the organization to which the Release applies to be Highlighted on the map.  Double clicking on an entry also causes the dialog to be closed.  Clicking on Delete will delete the selected Release.


Add Release Dialog


�xe "Add Release Dialog"�


The Add Release Dialog is used to define a Release for Fixed units.





�Find the unit or organization that the Release applies to in the Organizations Tree Control (this control has the same interface features as the Unit Dialog).  A Release may be applied to any unit or organization in the Order of Battle.  The Year, Month, and Hour selections are used to establish the date of the Release.  When the Is Triggered check box is selected, it indicates that the Release can also be triggered whenever a unit in the organization becomes Spotted.  The Probability value is the percent chance, between 1 and 100, that the Release will occur on the exact Release date.  If the Probability is not 100, then the Probability is used on each turn starting with the Release date to determine if the Release occurs on that turn.  For example, if the Release probability is 50, then there is a 50% chance the Release will occur on the exact Release date.  If it does not occur on the Release date, then there is a 50% chance it will occur on the next turn, and so on for each turn until it is determined to have occurred.  If the Probability is 0, then the Release automatically is considered Triggered.


Strength Dialog


�xe "Strength Dialog"�


The Strength Dialog is used to display the total strengths of all on-map units.





�The strengths of all units of each side are displayed by the various levels, Army, Division, Brigade, etc. that make up each side.  The strengths are listed in terms of men, guns, vehicles, airplanes, and ships.  The strength totals include all on-map units, all units scheduled to arrive as reinforcements, and all air support.


Objectives Dialog


�xe "Objectives Dialog"�


The Objectives Dialog is used to display a complete list of all of the Objectives associated with the current scenario and their assigned owner.





�Each Objective is listed with owner, location in hex coordinates, and value.  Selecting an Objective will scroll the map to the Objective location.  Double-clicking on a selection will also close the dialog.  Note: an Exit Objective will initially be shown with value 0 and will increase in value as units of the owning side are removed from the map at that location.


Supply Sources Dialog


�xe "Supply Sources Dialog"�


The Supply Sources Dialog is used to display a complete list of all of the Supply Sources associated with the current scenario and their owner.





�Each Supply Source on the map is listed with the owner, location, and value.  Selecting a Supply Source will scroll the map to the Supply Source location.  Double-clicking on a selection will also close the dialog.


Location Dialog


�xe "Location Dialog"�


The Location Dialog is used to display a list of all the map locations and to allow going directly to any of these locations.





�Each map location is listed with its label description and hex coordinates.  Selecting a location causes the map to scroll to the location’s hex coordinate.  Double clicking on a location also causes the dialog to be closed.


Jump Dialog





The Jump Dialog displays a reduced version of the entire map and allows the user to jump directly to any part of the map.





�The visible on-map units are displayed on the reduced map using blue squares for one side and red squares for the other side.  The visible portion of the map is shown using a red rectangle. Minefields that are currently visible are shown on the map as small gray rectangles.  When the Objectives option of the View Menu is set, then Objectives are shown as yellow squares.  The current Hot Spot hex is shown as a red outline square.  Clicking on the reduced map area causes the dialog to be closed and the regular map to scroll to the selected location.


When the Objectives option of the View Menu is set, then Objectives are shown as yellow squares.  Clicking on the reduced map area causes the dialog to be closed and the regular map to scroll to the selected location.


When an organization is Highlighted on the map, then an oval is drawn on the Jump Dialog�xe "Jump Dialog"� showing the approximate extent of that organization.





Organization Dialog


�xe "Organization Dialog"�


The Organization Dialog is used to highlight an organization on the map.





�All organizations in the Order of Battle are displayed in a Windows Tree Control.  Selecting an organization causes the on-board units in that organization to be Highlighted.  Clicking OK closes the dialog while keeping the organization highlighted on the map.  Clicking Cancel closes the dialog and cancels the highlighting.


Find Unit Dialog


�xe "Find Unit Dialog"�


The Find Unit Dialog can be used to find any given unit or organization that is on the map.





�Enter the name to be searched for in the Enter search field.  Note: the search is case-sensitive so you must enter your name with the proper capitalization (Panzer not panzer for example).  If you are confident that your search will produce a single result, you can hit return after typing the search name.  Otherwise, click on the Search button.  This will display a list of results in the Search results list.  Select the result you want and click on OK, or double click on the result you want, to close the dialog and find the result.  In the case of an organization, the organization will be Highlighted on the map.  In the case of an individual unit, the map will be scrolled to the unit’s location on the map.


Selection Dialog


�xe "Selection Dialog"�


The Selection Dialog is useful when then Editor is in Full Screen mode (see the View Menu).





�The Selection Dialog allows the units in the current Hot Spot to be displayed and selected.  The Selection Dialog is displayed by pressing the Space Bar.  You can make extended selections in the list of units displayed using the normal Windows list selection features.  For example, by holding down the Shift key and clicking with the left mouse button, you can select a range of units.  By holding down the Control (Ctrl) key and clicking with the left mouse button, you can select arbitrary units.


Parameter Data Dialog


�xe "Parameter Data Dialog"�


The Parameter Data Dialog displays the Parameter Data associated with the current scenario.





�The Parameter Data Dialog consists of a text listing of the scenario values.  The values are read from the PDT file corresponding to the current scenario.





The Parameter Data values are:





Time Parameters


Dawn (or Day): the time of first light.


Dusk (or Night): the time of sunset.


Day Turn: the number of hours in a turn during daylight.


Night Turn: the number of hours in a turn during night.


Has Dawn and Dusk Turns: determines if there are turns of reduced visibility at the beginning and end of the day.  These turns are otherwise considered day turns, but visibility during these turns is half what it would be otherwise.





Stacking Limits


Road: the maximum number of men, or equivalent in men, that can move using Road Movement.


Maximum: the maximum number of men, or equivalent in men, that can stack in a single hex.





Miscellaneous


Foot Speed: the speed at which motorized and mechanized infantry moves when moving by foot.


Infantry Defense: the default defense value of motorized and mechanized infantry when not in Travel Mode.


Digging-In: the percentage chance that a unit which is Digging-In will be successful in any given turn.  The probability is times 4 when the unit is constructing an Improved Hex, times 2 when the unit is an engineer, and normal when the unit is constructing a Trench Hex.


Fatigue Recovery: the average fatigue recovery for a unit per turn.  The recovery value is times 2 during night turns.


Bridge Values: the percentage chance that an Engineer unit building a bridge will complete the bridge in any given turn.  The chance is proportionally lower when the Engineer unit has less than 100 men.


Air Availability: the percentage chance that an air unit that has conducted an air mission will become available on a given turn.


Air Interdiction: the base percentage chance that a unit from the other side will attacked with an air interdiction attack while moving.


Interdiction Effect: the percentage applied to the attack value of air interdiction attacks.  This is used to take into account the size of the air and ground units in the game to balance interdiction losses relative to general air strikes.


Air Interception: the percentage chance that an enemy air mission will be intercepted by the given side.


SAM Interception: the percentage chance than an enemy air mission will be intercepted by SAM’s of the given side.


Electronic Warfare: the percentage chance that Electronic Warfare effects will apply to any one HQ unit within the required range of the enemy.


Rail Capacity: the total number of units from that side that can be moving in Rail Movement in any one turn.


Railroad Movement: the number of hexes a unit moving via Rail Movement can move in one turn.


Light, Medium, and Heavy Bridge Strength: the defense values used for the corresponding bridges when an Engineer unit attempts bridge destruction.


Infantry Strength Effectiveness: the effectiveness of infantry units is based on a calculation using the given values.  Linear interpolation is used to calculate the effectiveness of infantry units from this value to 100% and from this value to 0%.


Unit Recovery: the average percentage recovery a unit will have based on its losses during any turn that it is eligible for loss recovery.


Rubble Fire Value: this value is used to determine the probability that Indirect Fire and bombing attacks against a Village, Town, City, or Industrial hex will result in Rubble.  A file value against the hex of this value will have a 50% chance of creating Rubble in the hex.


Refuel Percentage: the percent chance that a per-turn refuel test will have compared with a normal refuel test as described in the Supply section of the Users Manual.


Dust Spotting: when this value is nonzero, then units which have moved outside of normal visibility may be spotted as unknown units based on a probability modified by this value.


Breakdown: when this value is nonzero, then units consisting of vehicles have a certain probability that they will lose strength while moving.  The details of this are described in the Movement section of the Users Manual.





Air Limitation


Visibility: under the Low Visibility Air Effects Optional Rule, these are the percentage of air units that will be available under the corresponding visibility ranges.


Air Strike Hex Limit: if nonzero, then this value determines the maximum number of airplanes that can attack any one hex in a single player turn.





Artillery Values


Counterbattery: the percentage modifier applied to the normal rules for counterbattery spotting when units from the other side fire Indirect Fire.


Stockpiling: this is the percentage chance that an eligible artillery unit of the given side will become Stockpiled in any single turn.


Stockpiled Fire: this percentage modifier is applied to the fire value of a Stockpiled unit from that side when it fires.  A value of 100% indicates no change to the fire value.


Artillery Set Up: this is the percentage chance that an indirect fire capable artillery unit of the given side will become Set Up and available for a fire mission after it has moved.  This value only applies under the Artillery Set Up Optional Rule.


Indirect Mod: this modifier is applied to the fire value of a unit conducting Indirect Fire during the opposing turn (or the Defensive Fire Phase).





Combat Values


Fire Low and High Values: these values are used in determining combat losses from fire.


Attacker Low and High Values: these values are used in determining combat losses to the attacker in an assault.


Defender Low and High Values: these values are used in determining combat losses to the defender in an assault.





Deception Values


Range: these values are used to determine the maximum range that Deception Units can be deployed.


Effect: these values are used to determine the effectiveness of Deception units in disrupting the movement of units of the other side..


Damage: these values are used to determine the effectiveness of Deception units in preventing Damage by the other side.


Detect: these values are used to determine the probability of a Deception unit of the given side being detected per turn.





Terrain Elevations


These are the elevations in meters assigned to various terrain types.





Movement Cost: by Unit Class


For each Unit Class, these values given the movement costs in points for each terrain type. The movement costs are divided into two groups: those for hex terrain and those for hexsides.  When the movement cost for a particular hex terrain is given as 0, such as for Water, then it indicates that the unit cannot move into that terrain.  The movement cost for a given hexside is the additional cost that hexside adds to the normal movement cost.  When the movement cost for a particular hexside is given as –1, such as for Cliffs, then it indicates that the unit cannot move through that hexside.





Movement Modifier: by Unit Class


For each Unit Class, these values give the percentage modifier applied to movement by units of the given class under the given ground conditions.





Movement Modifiers


ZOC Movement Multiplier: this is used to multiply the normal movement cost when a unit moves from one enemy ZOC to another enemy ZOC.  It reflects the increased cautiousness of the unit when making such a move.


Movement Elevation Modifier: the additional movement cost applied when moving from one hex to a hex of higher elevation.





Terrain and Hexside Combat Modifiers


The percentage modifiers applied to fire values when fire is targeted into the given terrain, or through the given hexside.





Combat Modifiers


For fortifications, these are the percentage modifiers applied to fire against targets in the given fortification.  In addition, for Pillboxes and Bunkers, the values given are the additional defense value applied to units defending in these fortifications.





Elevation Modifier: the percentage modifier applied when the target unit of direct fire is at a higher elevation than the firing unit, given in terms of elevation increments, up to a maximum of 5 increments.





Range Effect: this is the modifier applied to direct fire at a range of 2 hexes.


Air Support Dialog


�xe "Air Support Dialog"�


The Air Support Dialog displays a list of the air units assigned to the current scenario and allows this list to be edited.





�The Air Support Dialog consists of a listing of the air units in the current scenario.  Units in the list can be selected individually, or in groups by using the Ctrl and Shift keys.  Selecting units and clicking on the Increase button causes the strength of the selected units to be increased by one airplane up to the maximum strength of the units.  Selecting units and clicking on the Decrease button causes the strength of the selected units to be decreased by one airplane.  Selecting units and clicking on the Delete button will delete the units from the list.  Selecting units and clicking on the Availability button will allow you to make changes to the availability of air units, either by adding availability changes for the selected units, or by deleting availability changes already defined by invoking the Air Availability Dialog.





An air unit designated with the word RECON is a reconnaissance air unit that can be used for spotting, but not for air strikes.  An air unit designated with the word CARPET is a Heavy Bomber air unit that will use the Carpet Bombing rules when it is used for an air mission.  An air unit designated with the words SINGLE USE is a Single Use air unit that becomes Unavailable after it is used for an air mission.  An air unit designated with the word NIGHT is a Night Flying unit that can only be used for air missions during Night turns.





Air Availability Dialog





The Air Availability Dialog allows you to control the availability of air units associated with the current scenario.





�The Air Availability Dialog lists the changes in air unit availability defined for the current scenario.  Each entry is denote with the word AVAIL, meaning that the specified air units become available on the given date, or NOAVAIL meaning that the specified air units become unavailable on the given date.  Existing entries may be deleted using the Delete button.  To add an entry, you must first select the affected air units using the Air Support Dialog and then click on the Availability button in that dialog.  Once you have the Air Availability Dialog�xe "Air Availability Dialog"� displayed, you then click on the Add button.  This will display the Add Availability Dialog so that the date and effect of the change can be specified.





�When more than one air unit is affected by the entry, then only the name of the first air unit is listed, and dots (…) indicate that there are more.  Double-clicking on such an entry will display a complete list of the affected air units.


Add Availability Dialog


�xe "Add Availability Dialog"�


The Add Availability Dialog is used to specify the date and effect of a change in air unit availability.





�The Add Availability Dialog allows the date of the air availability change to be specified.  In addition, if the Becomes Available checkbox is checked, then the change will cause the specified air units to be available at the specified date.  Otherwise, if the checkbox is not checked, then the specified air units will become unavailable at the specified date.


Supply Source Dialog


�xe "Supply Source Dialog"�


The Supply Source Dialog allows Supply Sources to be placed and removed on the map.





�The Supply Source Dialog allows the side of the Supply Source and the value of the Supply Source to be assigned.  The Value of the Supply Source should range from 0 to 100.  A Supply Source with value 0 does not have an effect on supply in the game until a Supply Variation affects its value.  Assigning a Side of None will remove the Supply Source from the map.


Bridge/Ditch Damage Dialog


�xe "Bridge/Ditch Damage Dialog"�


The Bridge/Ditch Damage Dialog allows Bridge and/or Anti-Tank Ditch Damage to be assigned on the map.





�The Bridge/Ditch Damage Dialog displays the six possible locations that Bridge or AT-Ditch Damage may be assigned in the current Hot Spot hex.  Clicking on any of these locations will set or clear the Bridge or AT-Ditch Damage in that location.  Bridge Damage can be applied to any Light, Medium, or Heavy bridge on the map.


Corps Attachment Dialog


�xe "Corps Attachment Dialog"�


The Corps Attachment Dialog allows the current Corps Attachments defined for the current scenario to be viewed.





�The Corps Attachment Dialog list the Corps Attachments that have been defined for a particular side.  Each attachment is listed in terms of the name of the organization being attached, followed by an arrow (->), and followed by the name of the parent organization.  Selecting an entry and selecting the Delete button causes the attachment to be deleted.  Selecting the Add button causes the Add Attachment Dialog to be displayed so that new attachments can be defined.


Add Attachment Dialog


�xe "Add Attachment Dialog"�


The Add Attachment Dialog allows new Corps attachments to be defined.





�The Add Attachment Dialog lists the organizations that may be attached and the possible parent organizations they may be attached to.  Selecting an organization from the first list and an organization from the second defines an attachment.  Selecting OK adds this attachment to the list of attachments for the current scenario.


Supply Variation Dialog


�xe "Supply Variation Dialog"�


The Supply Variation Dialog is used to edit the Supply Variations in the scenario.





�The Supply Variation Dialog lists the Supply Variations in the scenario.  This shows:


The side the variation is associated with.


The percent probability that the variation will occur each day.


ONE TIME if the variation can occur at most once during the scenario.


The change the variation has on the supply level for the given side.


A Starting date unless the variation applies to the entire scenario.





Clicking on Add displays the Add_Supply_Variation_Dialog so that new Supply Variations can be added.  Clicking on Delete will delete the selected Supply Variation.


Add Supply Variation Dialog


�xe "Add Supply Variation Dialog"�


The Add Supply Variation Dialog is used to add new Supply Variations to the scenario.





�The Add Supply Variation Dialog allows the values of a new Supply Variation to be specified.  Each Supply Variation:


Has a starting date that determines when the variation starts to take effect.


Is assigned to a particular side.


Has a percent probability of occurring per day.


Can be a ONE TIME variation that is only applied once per scenario.


Has a change value which is the amount the variation affects the supply of the given side.


If you leave the date unchanged, then it will apply throughout the scenario.  If you specify a specific date for the Supply Variation, then it will not have any effect in the scenario prior to that date.


Withdrawal Dialog


�xe "Withdrawal Dialog"�


The Withdrawal Dialog is used to view, add, and delete the Withdrawals associated with the current scenario.





�


The Withdrawal Dialog lists the Withdrawals associated with the current scenario.  Selecting an entry causes the affected organization to be Highlighted on the map.  Selecting Delete will delete the selected Withdrawal.  Selecing Add will display the Add Withdrawal Dialog so that a new Withdrawal can be defined.


Add Withdrawal Dialog


�xe "Add Withdrawal Dialog"�


The Add Withdrawal Dialog allows new Withdrawals to be added to the current scenario.





�


Find the unit or organization that the Withdrawal applies to in the Organizations Tree Control (this control has the same interface features as the Unit Dialog).  A Withdrawal may be applied to any unit or organization in the Order of Battle.  The Year, Month, and Hour selections are used to establish the date of the Withdrawal.  The Probability value is the percent chance, between 1 and 100, that the Withdrawal will occur on the exact Withdrawal date.  If the Probability is not 100, then the Probability is used on each turn starting with the Withdrawal date to determine if the Withdrawal occurs on that turn.  For example, if the Withdrawal probability is 50, then there is a 50% chance the Withdrawal will occur on the exact Withdrawal date.  If it does not occur on the Withdrawal date, then there is a 50% chance it will occur on the next turn, and so on for each turn until it is determined to have occurred.


A/I Order Dialog


�xe "A/I Order Dialog"�


The A/I Order Dialog is used to view and delete A/I Orders defined for the current scenario.





�The A/I Order Dialog displays a list of A/I Orders that have been defined for the current scenario.  You use the Add A/I Order feature of the A/I Menu to add A/I Orders.  Selecting an entry in the list will scroll the map to the destination of the order and Highlight the corresponding organization. Selecting Delete will delete the selected A/I Order.


Shift Dialog


�xe "Shift Dialog"�


The Shift Dialog is used to shift units on the map from one location to another.





�The Shift Dialog allows you to enter X and Y values to shift units on the map.  A unit at coordinates (A, B) will end up at coordinate (A+X, B+Y) after the shift.  The shift values can be positive, zero, or negative.  Positive X values move the units to the right while negative X values move them to the left.  Positive Y values move the units down while negative Y values move them up.  Associated map data such as the location of objectives, supply sources, and fortifications are also shifted.  Units or other data that is shifted beyond the boundaries of the map are deleted from the scenario.  Reinforcement arrival locations are shifted, but in this case, if the location ends up outside the map, the reinforcement is retained at the limit of the map boundaries.


Anti-Tank Ditch Dialog


�xe "Anti-Tank Ditch Dialog"�


The Anti-Tank Ditch Dialog is used to establish or remove Anti-Tank Ditches on the map.





�The Anti-Tank Ditch Dialog allows you to specify any combination of directions you want AT-Ditches to be established in the current hex.  Unchecking a direction will cause the AT-Ditch in that direction to be removed from the map.


SAM Site Dialog


�xe "SAM Site Dialog"�


The SAM Site Dialog is used to place specific SAM sites on the map so as to define a limited SAM coverage area.





�Using the SAM Site Dialog, you specify the side the site will be owned by and the range of the site.  The site will be created on the current Hot Spot location and define SAM coverage for the given range around that hex.


AI Bridge Command Add Dialog


�xe "AI Bridge Command Add Dialog"�The AI Bridge Command Add Dialog is used to add a new A/I Bridge Command to the existing scenario.





�The AI Bridge Command Add Dialog allows you to specify the side the command applies to, the location and direction the command applies to, the type of command, and the turn that the command should be applied.





There are three types of A/I Bridge Commands:


Build – causes the A/I to build an engineer bridge using the given information on the turn specified.


Unbuild – causes the A/I to unbuild any existing engineer bridge in the given hex and direction, or in the opposite hex from that location.


Damage – causes the A/I to attempt bridge or tank ditch damage in the given hex and direction on the turn specified and all subsequent turns.


AI Bridge Command View Dialog


�xe "AI Bridge Command View Dialog"�The AI Bridge Command View Dialog is used to view all A/I Bridge Commands in the current scenario and to modify or delete them.





�The AI Bridge Command View Dialog list all A/I Bridge Commands defined in the current scenario.  Clicking on an entry in this list will scroll the map to the specified hex location.  Clicking on the Modify button displays the AI Bridge Command Add Dialog so that the selected entry can be modified.  Clicking on the Delete button will delete the selected entry.


AI Deception Deploy Hex Dialog


�xe "AI Deception Deploy Hex Dialog"�The AI Deception Deploy Hex Dialog is used to view and delete hexes specified to be used by the A/I for deploying Deception Units.





�The AI Deception Deploy Hex Dialog displays a list of hexes that have been specified using the A/I Menu as Deception Deploy hexes.  These will be used by the A/I when decided where to deploy Deception Units.  Selecting an entry will scroll the map to that location.  Clicking on the Delete button will delete the selected entry.


Hex Coordinate Dialog


�xe "Hex Coordinate Dialog"�


The Hex Coordinate Dialog is used to jump to a specific hex location on the map.





�The Hex Coordinate Dialog allows you to enter the X and Y coordinate of the hex you want to go to.  When you click on the OK button, the map will automatically scroll to those hex coordinates.








Other Features


Creating Submaps


�xe "Creating Submaps"�


Although the Modern Campaign games do not have a map editor, it is still possible to create new maps from existing maps using the Submap feature.  Submaps are created by hand using a standard text editor such as Notepad.  Start by creating a new file with the filename extension map.  This file should include the following information which you enter by hand:


Line 1: The number 0 indicating that this file contains submap information.


Line 2: The filename of the larger map you are making a submap from.


Line 3: Four numbers indicating:


The map coordinates in the larger map of the upper-left-hand corner of the submap, and


The width and height of the submap in hexes.


Note: the first map coordinate value must be an even number.





Here is an example of a submap called Utah_Sub.map:


0


Normandy.map


48 31 26 17


This file has three text lines:


The first having the number 0 indicating submap


The second having the filename Normandy.map indicating the larger map that this submap is taken from


The third having the map coordinates (48,31), width of 26, and height of 17 indicating that the upper-left-hand corner of the submap is at map coordinates (48,31) of the larger Normandy map.





Once you create a submap, it can be used normally to create new scenarios using the Scenario Editor.  When you create a submap file, be sure to save the file in plain text format with no word-processing formatting included.  If you can open the file in Notepad and it appears just as you typed it, then it should work fine.


Hex Info Area





The Hex Info Area displays a list of the units in the Hot Spot hex and information about the terrain in that hex.  By default, the Hex Info Area�xe "Hex Info Area"� is displayed on the left hand side of the screen.  However, this may be changed using the Settings Menu.





Terrain Information


�The Terrain Box at the end of the unit list displays information about the current Hot Spot hex.  The first line of the display describes the type of terrain (in this case Clear) and the percentage benefit a unit will receive when fired upon by virtue of that terrain.  The second line of the text area shows the Elevation of the current hex in meters.  The third line of the text area shows the current Visibility in hexes.  The fourth line of the text area shows the Supply values of the two sides respectively.





Two other conditions may apply to the current hex:


The hex may contain RUBBLE as a result of bombing or indirect fire.  In this case, no road movement is possible through the hex and other movement costs are tripled.


The hex may be defined as being IMPASSIBLE.  In this case, it has been defined to be out of bounds for movement in the current scenario.


The hex may be labeled as having CHEMICALS which indicates that chemical weapons have been fired into the hex.





�When the current Hot Spot is an Objective hex, then the Objective value of the hex is also shown.  Note: Exit Objective hexes will have the word Exit on this line.





�When the current Hot Spot hex contains Mines or Fortifications, then this is also displayed in the Terrain Box.  By default, these will be shown using uppercase names.  When the word MINES appears in lowercase as in Mines, it indicates that the mines in that hex have been Penetrated.  When the fortification name, such as IMPROVED, appears in lowercase as in Improved, it indicates that the fortification has been Vacated.





When the current hex contains a bridge over a water hex, three possible descriptions may be shown:


Bridge – the bridge is in good condition and can be used for movement.


WIRED – the bridge is in good condition, but has been wired for demolition.


DAMAGED – the bridge has been damaged and cannot be used for movement.





Alternative Terrain Information


�Clicking on the Terrain Box with the right mouse button causes the display to change to the Alternative display.  In this display, the text area changes to show a description of the various hex sides that are present in the hex.  The names of the hex sides are arranged in a rough hexagonal pattern around the center of the text area showing the position of the hex side with respect to the hex.  The value in the center of this display is the number of men, or equivalent strength, in the hex.  If the letter X follows this number, then the number of men, or equivalent, in the hex exceeds the Road Movement stacking limitation.





Unit Information


�The Hex Info area�xe "Hex Info Area"� is filled with Unit Box displays.  The number of these depends on your screen resolution.  The Unit Box shows a representative picture of the unit, its name, its Strength (in men, vehicles, guns, etc.), its Movement value, its Morale, and its current Fatigue level (in values from 0 to 900).  If the name is followed by three plus signs (+++), then it indicates that the unit is a Combined Unit.  Other conditions associated with the unit are displayed as follows:


If the Strength value is displayed in Yellow, it indicates that the unit is at less than full strength.


If the Morale level is displayed in Yellow, it indicates that the unit’s morale is reduced for some reason such as fatigue or ammo level.


When the Movement value is followed by the letter T, it indicates that the unit is in Travel Mode.


When the Movement Value is followed by the letter R, it indicates the unit is in Rail Mode.


When the Fatigue level is shown in Green, it indicates that the unit has Low Fatigue.


When the Fatigue level is shown in Yellow, it indicates that the unit has Medium Fatigue.


When the Fatigue level is shown in Red, it indicates the unit has High Fatigue.





When the unit has the word Facing appearing over its unit picture, then the unit has a defined direction that it can fire in.  It can also fire in either of the two adjacent directions.  For example, if the unit has Facing Up Right, then the unit can fire at targets in the Up Right direction and in addition, in the Up direction and the Down Right direction from the firing unit.





Alternative Unit Information


�Clicking on a Unit Box with the right mouse button causes a pop-up window to appear showing the command hierarchy of the unit.  From top to bottom, the window lists the unit’s component, the unit name, the unit’s organization, the next higher organization and so forth.  In addition, in this mode, other values associated with the unit are displayed.


Following the word Hard are the attack value and range respectively that are used when the unit fires on a Hard Target.


Following the word Soft are the attack value and range respectively that are used when the unit fires on a Soft Target.


For Headquarters, the value following the word HQ indicates the Command Range of the unit.


The value following the word Assault is the assault attack value of the unit.  


The values following the word AA are the attack value and range respectively that are used when the unit fires Anti-Aircraft fire on enemy air strikes.


The value following the word Defense is the defense value of the unit.  When the Defense value is shown in Yellow, it indicates that this is a motorized or mechanized infantry unit that is currently on foot.


The words Hard Target will appear when the unit is an armored target.  


The Speed of the unit in kilometers per hour is also listed.  When the Speed is shown in Yellow, it indicates that this is a motorized or mechanized infantry unit that is currently on foot.





Other units with specialized functions will also have indications of this such as:


Indirect Fire, indicating the ability to fire indirectly.


Chemical, indicating the ability to fire chemical weapons.


IF/Chemical, indicating the ability to fire indirectly and to fire chemical weapons.


Towed Guns, indicating that the unit must be in Travel Mode to move.


Mine Clear, indicating an ability to clear minefields.


Bridge Eng, indicating an ability to build Engineer Bridges.


Mine/Bridge, indicating both mine clearing and bridge building abilities.


Amphibious, indicating an ability to cross rivers and canals.


Rail Unit, indicating that the unit is restricted to traveling by Rail Mode.


Recon, indicating an ability to be used with the Recon Spotting Optional Rule.


Single Use, indicating that the unit can only be used for the current turn and then will be removed from the game.





�When an organization has been attached, then the name of the new superior organization is prefaced with the notation "=>" as shown in the picture.  This example indicates that the 11th Armored Cavalry has been attached to the VII Corps.





� When there are more units in the Hot Spot hex than can be displayed in the available Unit Boxes, then scroll arrows that appear after the list of units can be used to scroll the Unit Boxes.  When the left or top arrow is displayed in full color, there are units to the left or top of the displayed units and when the right or bottom arrow is displayed in full color, there are units to the right or bottom of the displayed units.  In addition, the numbers which appear associated with each scroll arrow indicate the number of hidden units in the corresponding direction.





Toolbar


�xe "Toolbar"�


The Editor has a Toolbar that exists at the top of the Editor window just under the Menu Bar.  Note: depending on your screen resolution, only some of these buttons may be displayed on your screen.  You need a screen width of at least 1024 before all of the buttons are displayed unless you have selected the Complete Toolbar Option.  Note that most all of these buttons implement a menu selection and the command may be issued as a menu selection when the button is not displayed.





�Mode - toggles the Editor mode between Place Mode (when pressed) and Move Mode (when unpressed).





�New - clears any existing scenario data and starts a new scenario from scratch.


�Open - opens an existing scenario file.


�Save - save current scenario under existing filename or prompt for filename if none.





�Counterclock - turn the selected units counterclockwise.  Note: this only has a visual effect in 3D graphics mode and does not affect game play.


�Clockwise - turn the selected units clockwise.  Note: this only has a visual effect in 3D graphics mode and does not affect game play.


�Travel Mode – toggle the selected units between Travel Mode and non-Travel Mode.


�Increase Strength - increase the strength of the selected units.  Holding the Alt key while pressing this button increases the strength by 10.


�Decrease Strength - decrease the strength of the selected units.  Holding the Alt key while pressing this button decreases the strength by 10.


�Increase Fatigue - increase the fatigue of the selected units.  Holding the Alt key while pressing this button increases the fatigue by 10.


�Decrease Fatigue - decrease the fatigue of the selected units.  Holding the Alt key while pressing this button decreases the fatigue by 10.


�Disrupted - toggle the disrupted state of the selected units.


�Fixed - toggle the Fixed state of the selected units.


�Combine/Breakdown – either combine the selected units into one Combined Unit or breakdown a Combined Unit into a subunit. Note: holding down the Alt key when selecting this option will cause all possible units in the current hex to be Combined regardless of which units you have selected.


�Remove - remove selected units from map.





�Set Objective - display the Set Objective Dialog so that an Objective can be set or deleted in the current Hot Spot hex.


�Set Supply Source - display the Supply Source Dialog so that an Objective can be set or deleted in the current Hot Spot hex.


�Toggle Improved – toggle Improved Position add or clear mode where Improved Positions are added by clicking with the left mouse button and removed by clicking with the right mouse button.


�Toggle Trench – toggle Trench add or clear mode where Trenches are added by clicking with the left mouse button and removed by clicking with the right mouse button.


�Add/Clear Mines – toggle Mine add or clear mode where Mines are added by clicking with the left mouse button and removed by clicking with the right mouse button.


�Toggle Bunker – toggle Bunker add or clear mode where Bunkers are added by clicking with the left mouse button and removed by clicking with the right mouse button.


�Toggle Pillbox toggle Pillbox add or clear mode where Pillboxes are added by clicking with the left mouse button and removed by clicking with the right mouse button.





�Zoom In - increase the scale of the map.


�Zoom Out - decrease the scale of the map.


Normally the screen is recentered on the Hot Spot hex when you change zoom modes.  If you hold down the Alt key when you change zoom modes, the screen will retain the current view.


�Units - toggle the display of units on the map.


�Bases - toggle the display of unit bases on the 3D map.


�Objectives - toggle the display of objectives on the map.


�Visible Hexes - toggle the display of hexes visible from the current Hot Spot hex.


�Contours - toggle the display of elevation contours on the map.


�Jump Dialog - display the Jump Dialog so you can quickly go to another part of the map.





�Highlight Fixed - toggle the Highlight of Fixed units.


�Highlight Disrupted - toggle the Highlight of Disrupted units.


�Highlight Low Ammo - toggle the Highlight of units that are Low-On Ammo.


�Highlight Organization - toggle the Highlight of all units in the same organization as the top selected unit.  Holding the Alt key while pressing this button causes the next higher organization to be highlighted.





�General Help - display this help file.


Hot Keys





The following Hot Keys are supported in the Editor.  Note that these Hot Keys�xe "Hot Keys"� are defined as command accelerators of the Editor main window and therefore the Editor main window must have the keyboard focus for these to work (that is, the Editor main window must have a highlighted title bar).





Shift Key - display the on-map labels while this key is pressed.


Space Bar - display the Selection Dialog (useful in Full Screen mode).


F1 - invoke General Help (display this help file).


B - move the selected units backward in the Hot Spot hex (Note: this only has a visible effect in the 3D graphics mode).


D – decrease the strength of the selected units by 1.  If you hold down the Alt key while pressing this key, then the strength is decreased by 10.


F - move the selected units forward in the Hot Spot hex (Note: this only has a visible effect in the 3D graphics mode).


H – toggle display of maximum range of selected units.


I – increase the strength of the selected units by 1.  If you hold down the Alt key while pressing this key, then the strength is increased by 10.


J – display the Jump Dialog.


L - turn the selected units counterclockwise.


O - highlights the Organization for the selected unit. If an organization is currently selected and you hold down the Alt key when invoking this function, then the next higher organization is selected.


P – display the Organization Dialog.


Q – highlights HQ units on the map.


R - turn the selected units clockwise.


S – shade Visible Hexes from the current Hot Spot.


T – toggle Travel Mode for the selected units (see the View Menu).


V – toggle the display of Divisional Markings (see the View Menu).


W – highlights Indirect Fire Spotters (see the View Menu).


X - remove the selected units from the map.


Z – toggle Full Screen Mode (see the View Menu).


1 - display the map in Zoom-Out 2D mode.


2 - display the map in Normal 2D mode.


3 - display the map in Zoom-Out 3D mode.


4 - display the map in Normal 3D mode.


Normally the screen is recentered on the Hot Spot hex when you change zoom modes.  If you hold down the Alt key when you change zoom modes, the screen will retain the current view.


Keypad 0 - change the Travel Mode of the selected units.


Keypad 1 - move the selected units down and to the left one hex.


Keypad 2 - move the selected units down one hex.


Keypad 3 - move the selected units down and to the right one hex.


Keypad 4 - turn the selected units counterclockwise.


Keypad 5 - turn the selected units about-face.


Keypad 6 - turn the selected units clockwise.


Keypad 7 - move the selected units up and to the left one hex.


Keypad 8 - move the selected units up one hex.


Keypad 9 - move the selected units up and to the right one hex.


Delete - move the selected units counterclockwise.


Page Down - move the selected units clockwise.


Home - move the selected units forward in the Hot Spot hex (Note: this only has a visible effect in the 3D graphics mode).


End - move the selected units backward in the Hot Spot hex (Note: this only has a visible effect in the 3D graphics mode).


Hot Spot


The hex on the map currently selected with the red hex outline.





Parameter Data


Basic data from the pdt file that applies to the current scenario.





Move Mode


The mode where clicking on the map with the right mouse button causes the currently selected units to be moved to the selected hex.





Place Mode


The mode where right clicking on the map causes the currently selected unit in the Unit Dialog to be placed on the map.





Hot Key


A keyboard character which when typed performs the same function as a menu selection or toolbar button.





Highlight


To display a unit on the map with a red or white outline.





Fixed


Units which are Fixed cannot move until Released, spotted , or assaulted.


Exit Objective


An Exit Objective awards points to the side owning the Objective for each unit that is removed from the map from the Objective hex.


Low Fatigue


A Fatigue level from 0 through 99.





Medium Fatigue


A Fatigue level from 100 through 199.





High Fatigue


A Fatigue level of 200 or higher.





Vacated


When all of the units leave a fortified hex, such as Improved, Trench, Bunker, or Pillbox, it is considered Vacated and only provides any subsequent units with half the normal defensive benefit.





Penetrated


When units enter a hex containing Mines, it is considered Penetrated and no longer blocks supply.





Travel Mode


Travel Mode is the opposite of being deployed for combat.  In this mode, units can use Road Movement but are more vulnerable to combat results.





Rail Mode


Units in Rail Mode are considered boarded on rail cars and are capable of moving via Rail Movement.





Combined Unit


A Combined Unit consists of several other units each with the same Component and Quality and all from the same organization.





Stockpiled


Stockpiled artillery units fire at increased effectiveness.





Withdrawal


When a Withdrawal takes effect, all non-Isolated units belonging to the associated organization are automatically removed from the current battle.





Facing


Units which have a defined Facing can only fire in the direction of the facing plus the two adjacent directions.





Single Use


Units which are Single Use can only be used for a single turn in the game and then are automatically removed.
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